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Análisis de Agua Subterránea 
Transitoria 

 
 

Un análisis de Agua subterránea transitoria puede ser importante 
cuando hay un cambio tiempo- dependiente en la presión de poros. 
Esto tomará lugar cuando cambien las condiciones de límite de agua 
subterránea y la permeabilidad del material sea baja. En este caso, 
tomará un monto finito de tiempo para alcanzar las condiciones de 
flujo de estado estacionario. Las presiones de poros transitorias 
podrían tener un gran efecto en la estabilidad del talud. 
 
Este tutorial describe cómo llevar a cabo un análisis de agua 
subterránea transitoria en el  Slide, al utilizar los elementos finitos. 
En un tutorial subsecuente se describirán como esto afecta los cálculos 
de estabilidad del talud. 
 
Se puede encontrar el producto terminado de este tutorial  en el 
archivo de datos Tutorial 18 Agua Subterránea Transitoria.slim 
(“Tutorial 18 Transient Groundwater.slim”). Se puede acceder a 
todos los archivos de los tutoriales instalados con  Slide 6.0, al 
seleccionar Archivo > Carpetas Recientes > Carpeta de Tutoriales 
(“File > Recent Folders > Tutorials Folder”) desde el menú principal 
del  Slide. 
 
 
Temas Desarrollados 
 

• Análisis de filtración de agua subterránea de elemento finito 
 

• Agua subterránea transitoria 
 
 
 
Geometría 
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Modelo (“Model”)___________________________________________ 

 
 

Inicie el programa Modelo (“Model”) del  Slide. 
 
 
Parámetros del Modelo (“Project Settings”) 
 
Abra la ventana de diálogo Parámetros del Proyecto (“Project 
Settings”) desde el menú Análisis (“Analysis”). Configure las 
Unidades de Tensión (“Stress Units”) a Métrico (“Metric”), configure 
las Unidades de Tiempo (“Time Units”) a Horas (“Hours”) y las 
Unidades de Permeabilidad (“Permeability Units”) a metros/segundo, 
tal como se muestra a continuación. 
 
 

 
 
Haga clic en el enlace Agua Subterránea (“Groundwater”) en el lado 
izquierdo. Deje el Método (“Método”) como Superficies de Agua 
(“Water Surfaces”). Seleccione la casilla de selección Advanced 
(“Avanzado”) y elija Agua Subterránea Transitoria (“Transient 
Groundwater”). 
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EL Método (“Method”) se refiere al método utilizado para obtener el 
estado inicial para llevar a cabo el análisis de agua subterránea 
transitoria. En este tutorial especificaremos simplemente una napa 
freática inicial, pero también es posible especificar una cuadrícula de 
presiones de poros o llevar a cabo asimismo, un análisis de elemento 
finito de estado estacionario para obtener el estado inicial. Esto se 
discute posteriormente en los siguientes tutoriales. 
 
Ahora haga clic en el enlace Transitorio en la izquierda. Aquí 
necesitamos especificar los tiempos en los cuales deseamos observar 
los resultados de la presión de los poros. Cambie el Número de Etapas 
(“Number of Stages”) a 5. Ingrese los tiempos para cada etapa, tal 
como se muestra. 
 

 
 
No coloque check en las casillas para Calcular el SF (“Calculate SF”) 
(factor de seguridad). En este tutorial, nosotros sólo observaremos al 
modelado de agua subterránea. Un tutorial subsecuente combinará 
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esto con el cálculo de estabilidad del talud. 
 
Haga clic en OK para cerrar la ventana de diálogo Parámetros del 
Proyecto (“Project Settings”). 
 
Ahora, usted verá una pantalla en blanco con dos tabuladores en la 
parte inferior. Una para la Estabilidad del Talud (“Slope Stability”) y 
la otra para el Agua Subterránea (“Transient Groundwater”). La 
primera parte de este tutorial incluye configurar la geometría del 
modelo. Esto sólo se puede llevar a cabo en el modo Estabilidad del 
Talud (“Slope Stability”), entonces haga clic en el tabulador para 
Estabilidad del Talud (“Slope Stability”)     
 
Límites (“Boundaries”) 
 
El modelo representa una presa con un pie de drenaje. En esta parte, 
definiremos la geometría del problema. 
 
Asegúrese que usted se encuentre en la vista Estabilidad del Talud 
(“Slope Stability”). Seleccione la opción  Añadir Límite Externo 
(“Add External Boundary”) en el menú Límites (“Boundaries”) e 
ingrese las siguientes coordenadas: 
 

0 , 0 
 
20 , 10 
 
24 , 12 
 
28 , 12 
 
52 , 0 
 
40 , 0 
 
c  (para cerrar el límite) 

 
Presione Ingresar (“Enter”) para finalizar la entrada de puntos. Este 
modelo lucirá así: 
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Materiales (“Materials”) 
 
 Seleccione Definir Materiales (“Define Materials”) desde el menú 
Propiedades (“Propiedades”). Cambie el nombre de Material 1 
(“Material 1”) a Suelo (“Soil”). No nos preocupemos por el resto de los 
materiales, ya que nosotros sólo llevaremos a cabo un análisis de agua 
subterránea; por lo tanto, déjelos con sus valores por defecto. 
Seleccionaremos los parámetros de flujo de agua subterránea 
posteriormente. 
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Haga clic en OK para cerrar la ventana de diálogo. Por defecto, toda la 
presa está configurada para Material 1 (Suelo(“Soil”)), entonces no 
necesitamos asignar ninguna propiedad de material. 
 
 
Napa Freática Inicial (“Initial Water Table”) 
 
En la vista Estabilidad del Talud (“Slope Stability”), usted también 
puede especificar la napa freática inicial que tiene lugar antes del 
análisis de agua subterránea transitoria. Para este tutorial, 
asumiremos que la napa freática inicial está en la base de la presa, 
entonces no necesitamos especificarla. Si no se especifica la napa 
freática posteriormente, todos los puntos tendrán una presión de 
poros inicial de 0. 
 

 
 
 

Agua Subterránea (“Groundwater”)___________________________________ 
 
 

Ahora, es tiempo de configurar el modelo de elemento finito 
para calcular el comportamiento de agua subterránea 
transitoria; entonces, seleccione el tabulador para el Agua 
Subterránea (“Transient Groundwater”) en la parte 
inferior de la pantalla. 
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Malla (“Mesh”) 
 
Antes que podamos configurar las condiciones de límite, 
necesitamos crear una malla de elemento finito. Esto se puede 
hacer fácilmente, seleccionando Malla → Discretizar y 
Malla (“Mesh → Discretize and Mesh”). El modelo debe 
lucir como esto: 
 
 

 
 
 
Condiciones de Límite (“Boundary 
Conditions”) 
 
Configuraremos las condiciones del límite para estimular el 
rápido llenado de la presa en la parte izquierda y drenaje 
desde el pie del drenaje en la parte inferior derecha. 
 
 
Seleccione Malla → Configure Condiciones de Límite 
(“Mesh → Set Boundary Conditions”). Para el Tipo BC, 
elija Altura Manométrica Total (“Total Head”) y configure el 
Valor de la Altura Manométrica Total (“Total Head Value”) a 
10 m. 
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Haga clic en el lado izquierdo del talud, cerca de la parte 
inferior y haga clic en Aplicar (“Aplicar”). El modelo debe lucir 
como así: 
 
 

 
 
Ahora para el Tipo BC, elija Presión Cero (“Zero Pressure”). 
Haga clic en la sección horizontal en la parte derecha inferior 
del modelo (al pie del drenaje). Haga clic en Aplicar (“Apply”). 
Haga clic en Cerrar (“Close”) y el modelo debe lucir como esto: 
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Propiedades del Material (Agua Subterránea) 
(“Material Properties (Groundwater)”) 
 
Seleccione Propiedades → Definir Propiedades 
Hidráulicas (“Properties → Define Hydraulic 
Properties”). Las propiedades hidráulicas solicitadas para 
un análisis transitorio son las mismas que para las del 
análisis de estado estacionario, excepto que se debe especificar 
ahora una curva de retención de agua (WC). 
 
En esta parte, usted puede seleccionar un número de posibles 
curvas que relacionan la permeabilidad y retención del agua 
con la presión de poros negativa (succión). Para este tutorial, 
definiremos nuestra propia relación. 
 
Haga clic en el botón Nuevo (“New”) para definir una nueva 
función. Cambie el Nombre a Curva de Suelo (Soil Curve). 
Asegúrese que se haya seleccionado el tabulador de 
Permeabilidad (“Permeability”) e ingrese los valores, tal como 
se muestra.  
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Usted puede ver que la permeabilidad será de 1e-7 m/s, hasta 
que la succión exceda 15 kPa, tiempo en el que la 
permeabilidad descenderá con la succión en aumento. 
 
Ahora, necesitamos definir la relación entre el retención de 
agua y la succión. La retención del agua volumétrico (θ) es el 
volumen de agua como una porción de volumen total (θ = 
Vw/VT). Usted también puede pensar en eso, ya que la 
porosidad mide el grado de saturación (θ = φSw), donde el 
grado de saturación oscila entre 0 (seco) a 1 (saturado).  
 
Haga clic en el tabulador Retención del Agua (“Water 
Content”). Ingrese los valores tal como se muestra. 
 
 

 
 
Usted puede observar que en una succión matricial 0, la 
retención del agua es 0.4. Si asumimos que el material está 
100% saturado en esta presión, entonces esto sugiere una 
porosidad de 0.4. Si la succión matricial incrementa, la 
retención del agua disminuirá, lo que sugiere un descenso en 
saturación. 
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Haga clic en OK para cerrar la ventana de diálogo. 
 
En la ventana de diálogo Definir Propiedades Hidráulicas 
(“Define Hydraulic Properties”), asegúrese que la Curva del 
Suelo (“Soil Curve”) es el modelo elegido. Deje todos los otros 
valores tal como se muestran por defecto. 
 
 

 
 
Haga clic en OK para cerrar la ventana de diálogo. 
 
 
Computar (“Compute”) 
 
Guarde el modelo, utilice la opción Guardar Como (“Save As”) 
en el menú Archivo (“Archivo”). Elija Computar 
(“Compute”) (agua subterránea) desde el menú Análisis 
(“Analysis”) para llevar a cabo el análisis. Cuando finalice, 
elija Interpret (“Interpret”) (agua subterránea) desde el 
menú Analysis (“Analysis”) para visualizar los resultados. 
 
Interpretar (“Interpret”) 
 
Usted observará primero el estado inicial. Todas las presiones 
de los poros son 0. Haga clic en el tabulador para Etapa 1 
(“Stage 1”) (10 horas). Ahora, usted verá la presión de cabeza 
para la Etapa 1 (Stage 1) (10 horas). 
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Usted podrá ver cómo el incremento rápido en el nivel del 
agua en el margen izquierdo ha inducido las presiones de 
poros altas a lo largo del flanco izquierdo, pero que el agua no 
ha fluido aún a través de la presa para incrementar las 
presiones en otro sitio. 
 
Haga clic en otras etapas, utilizando los tabuladores 
inferiores. Usted verá que la progresión del agua subterránea 
con el tiempo y particularmente el cambio de napa freática 
(línea rosada). 
 
Haga clic en el tabulador para la Etapa 5 (10000 horas). Esto 
representa esencialmente el estado estacionario. Usted puede 
ver la progresión de la napa freática con el tiempo, al dirigirse 
a Visualizar → Mostrar Opciones (“View → Display 
Options”). Seleccione el tabulador Agua Subterránea 
(“Groundwater”) y mediante el agua de FEA, seleccione 
Todas las Etapas (“All Stages”) tal como se muestra. 
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Haga clic en Hecho (“Done”). El gráfico lucirá como esto: 
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Usted puede ver que la línea rosada sólida representa la napa 
freática en 10,000 horas y que las líneas rosadas y punteadas 
representan la napa freática en otras etapas. Diríjase a  
Mostrar Opciones (“Display Options”) y desactive las napas 
freáticas.  
 
Muestre los vectores, al hacer clic en  la parte inferior de la 
barra de herramientas, Mostrar los Vectores de Flujo (“Show 
Flow Vectors”). El gráfico lucirá como de esta manera. 
 
 

 
 
Usted puede ver que el flujo del agua hacia el pie de drenaje 
en la parte inferior derecha. Si usted hace clic en los 
tabuladores de la etapa nuevamente, usted verá la progresión 
de flujo a través de la presa con el tiempo. 
 
 
Podemos observar con mayor detalle el cambio en la presión 
con el tiempo, al utilizar una búsqueda. Diríjase a Agua 
Subterránea → Búsqueda → Añadir Búsqueda de 
Material (“Groundwater → Query → Add Material 
Query”). Queremos examinar un punto cercano único de la 
presa; por lo tanto, ingrese las coordenadas 25,5. Presione 
Ingresar (“Enter”) para finalizar con los puntos de entrada. 
No haga clic en Mostrar Valores de Búsqueda (“Show Queried 
Values”), tal como se muestra. 
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Haga clic en OK. 
 
 
Ahora, verá un + cerca del medio de la presa, lo que indica que 
el punto de búsqueda (usted quizás necesitará desactivar los 
vectores de flujo para ver esto). Haga clic derecho en el + y 
seleccione Datos de Gráfico (“Graph Data”) vs. Tiempo 
(“Tiempo”). Ahora, usted observará un gráfico de presión de 
cabeza versus tiempo en la ubicación. 
 
 

 
 
A menudo es más informativo utilizar el logaritmo de tiempo. 
Para hacer esto, diríjase a Tabla → Propiedades de la 
Tabla (“Chart → Chart Properties”). Expanda el elemento 
de Ejes (“Ejes”) y cambie la Escala Horizontal Logarítmica 
(“Logarithmic Horizontal Scale”) a Sí (“Yes”), tal como se 
muestra. 
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Haga clic en Cerrar (“Close”). Ahora, la tabla lucirá así:  
 

 
 
Usted puede observar que la presión no alcanzó el punto hasta 100 
horas después aproximadamente, después de alcanzado el nivel de 
agua, y eso después de 100 horas, la presión de cabeza alcanzó a su 
valor de estado estacionario de ~2.4 m en 10,000 horas. 
 
 
 
Esto concluye este tutorial. 
 
 

 
 
Ejercicio Adicional  

 
 

Usted  querer ver si las 10,000 horas representan el verdadero estado 
estacionario. Usted puede hacer esto de dos formas: 
 
 

1.   Añada otra etapa en algún otro lugar (decir 20,000 horas) y 
observe si existe algún cambio. 

 
2.   Ejecute un análisis de estado estacionario (no estacionario) y 

observe si usted obtiene los mismos resultados. 
 
 


